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ActivInspire Migration 

Objectives 

 Learn the new tools of ActivInspire 
 Make the transition from ActivStudio to ActivInspire 
 Discover new sounds, flipcharts, graphics, etcé 
 Hands-on experience in the uses and benefits of ActivInspire 
 Work collaboratively in a group setting 

What is ActivInspire? 

ActivInspire is the new software produced by Promethean for the Promethean Interactive Whiteboards. 
 

What is new in ActivInspire? 

Å The flipchart is already set to Best Fit so that the page fits on the screen nicely.  
Å Profiles are preset to the task at hand: authoring, at the board, languages, math or media.  
Å Open flipcharts show as tabs across the top. You can easily move between the flipcharts.  
Å The Browser window now includes: resources (library), page browser, objects, notes, 
    properties, and action browsers. No more pop up boxes!  
Å Tools are added to your toolbox as you use them.  
Å Text boxes are more like regular word processing, with the tools across the top of the page.  
Å Handwriting and shape recognition works when not attached to the board. 

Discussing the Tools of ActivInspire 

 Tooboxes 
 

The toolboxes change in ActivInspire.  Note the former look of ActivStudio vs the new look of ActivInspire.  The toolbox 
and toolstrip are now combined together in Inspire.   

Activstudio Toolbox and Toolstrip    ActivInspire Toolbox 
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Main Toolbox 

The Main Toolbox is only displayed when working with a flipchart. This may be a Standard or Desktop Flipchart. 
Should you minimize the Flipchart Window, the toolbox will minimize as well.  Options for accessing tools for 
use with other applications will be addressed later. 

 
The Main Toolbox no longer has a Show/Hide Button. Flipcharts are now minimized or maximized using the 
operating system options. 

Å Tools no longer toggle on and off. 
Å Shortcut Bar now known as Quick Access Toolbox. 
Å The Object Edit Toolbox has been replaced with a Marquee Handles Toolbar and continues to reflect 

options relevant to specific object types. 
Å The Flipchart Toolstrip is not a feature in ActivInspire. The tools found there are now incorporated 

within the Main Toolbox, or the new Browser Window. 
Å The Page Edit Toolbox options are now accessed within a right-click menu or the Page Browser. 
Å The Quick Select Toolbox is not currently available. 

 
Shape Resources 
Shapes can still be added through the Resource folders. You will also find a new tool in ActivInspire that will 
offer you the opportunity to create special shapes of your own. 
NEW 
Shape Tool 
Directions for using the new Shape Tool to create Shape Objects are listed below: 
Å Click on the Shape Tool. 
Å Choose a shape from the Shapes Menu. 
Å Choose outline color of the shape from the Color Palette on the Main Toolbox. 
Å Choose the outline width with the Pen Slider or presets. 
Å Choose Fill Options (color fill or no fill) from the Color Palette within the Shapes Menu box. 
Å Move to the flipchart page, press and draw the shape to desired size. 

 
 
TOOL 

Connector Tool 
This is a new tool in ActivInspire. The Connector Tool is used to draw connections  
between objects on the flipchart page. For instance, it could be used to create concept maps. 
 
The connecting line adapts automatically when connected objects are moved. 
 
Directions for using the new Connector Tool to create connectors are listed below: 
Å Click on the Connector Tool. 
Å Choose a connector style from the Connector Menu. 
Å Choose line color from the Color Palette on the Main Toolbox. 
Å Choose the line width with the Pen Slider or presets. 
Å Move to the flipchart page, press and draw the line from one object to another. 
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Launching the Primary Look and Feel 
On the Dashboard  (F11) click on configure. Click inside the box to the left that says, ñLaunch next time using 
the Primary look and feel.ò Make sure the box is checked. Now you can close out of ActivInspire. The next you 
open ActivInspire it will have the Primary look and feel. To get back to the Studio look and feel open up the 
Dashboard  (F11) and click on configure. Click inside the box to the left that says, ñLaunch next time using the 
Studio look and feel.ò Make sure the box is checked. Now you can close out of ActivInspire. The next time you 
open ActivInspire it will have the Studio look and feel. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Desktop Tools 
Click the Desktop Tools Icon to open the Desktop Tools Wonderwheel. The Desktop Tools offer tools 
commonly used with other applications. 
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User Defined Buttons 
To add a customized User Defined Button, click on the Edit User Defined Button on the Quick Access Toolbox. 
The Edit User Profiles box will open to the User Defined Button Tab. 
Å Click the Add Button to add a Program or File to the Quick Access Toolbox. 
Å Browse to the Program/File or type in the Website URL. 
Å Add a Tooltip. 
Å Move the User Defined Button to the desired place on your toolbox with the Move Up or Move Down buttons. 
Å Click Done. 
Å The new button will appear on the toolbox. 
 
While in Edit Profiles, click Remove to delete a User Defined Button. 
 
 

Quick  Access Toolbar 
 

                       
                            Edit User Defined Button 

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 

 
 

Arrange Windows 
 
Arrange Windows is not available in ActivInspire. To move between open flipcharts, use the tabs at the top of the 
Flipchart Window. 
 
Note: If tabs do not show, check the View Menu to be certain they are enabled. 
 
Copy and paste pages between open flipcharts by: 
Å Using the Page Browser menus to copy/paste. 
Å Dragging a page from the active flipchartôs Page Browser to the receiving flipchartôs tab 
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Power Tools 
The tools known as Power Tools in previous versions of Activsoftware are available to be added to the toolbox or 
can be accessed through the Tools Menu. Tools commonly used for Math are found in the Maths Tools Menu 
within the Tools Menu. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Browsers 

What else is new with ActivInspire?  The Browsers.  The Inspire has seven browsers: page, resource, object, notes, properties, 
action, and voting.   
The Browser is on the left of the screen, but you can use the toolbox menu to move it.  Click on the Pin in the 
upper right corner to free the browser to hide when not in use.  Move the mouse to the left of the screen and 
click, then the browser will reappear.  Change the icon size with the slider at the bottom of the browser window. 
 
Page Browser           Resource Browser 
 
 
 
 
 
 
 
 
 
 
 
Object Browser          Notes Browser 



  6 ActivInspire Migration 

 

 
 
 
 
 
 
 
 
 `           Actions Browser 
 
 
 
Property Browser 
 
 
 
 
 
 
 
 
 Voting Browser 
 
 
 
 
 
 
  
 
 
New Browser Features 
 
Page Browser: 
 
Page Selector and Page Organizer options are located within the Page Browser. 
Å Access the Page Browser by clicking on the Page Browser Icon in the Browser Window. 
Å Use the thumbnails of the displayed pages to move about the flipchart. 
Å Click and drag pages to change their order. 
Å Use the slider to change the size of thumbnails. 
Å Use the menu in the top corner of a selected pageôs thumbnail to access menu options. 
 
Resource Browser 
 
Changes in the Resource Libraries: 
 Resources are now accessed through the Browser Window. Display the Browser Window and choose 

Resource Browser. 
 Category Buttons as they appeared in ActivStudio 3ôs Resource Library are not part of the Browser. The My 

Resources/Shared Resources and Other Resources Folder Buttons remain available. The top section of the 
Resource Browser will display the folders within each of the locations. The bottom section of the Resource 
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 Browser will display the contents of the folders. 
 My Resources Folders no longer include default Category folders. 
 Add objects with a Drag and Drop or choose to Rubber Stamp. The Grow Objects selection is not available at 

this time. 
 Continue to access any available resources on your computer or network through the Other 
 Resources Folder option. 
 Open files displayed in the Resource Browser with a double click. 
 The Search for Resources feature is not currently available. 

 
Object Browser 
 
Object stacking order and flipchart layers remain the same in ActivInspire as in previous versions.  An added 
feature to help with stacking and layering objects is the Object Browser. This browser displays detail of the objects 
on a flipchart page. 
 
The Object Browser allows a user to view: 
Å The order and layer of each object 
Å Hidden objects 
Å Locked objects 
The Object Browser can be used to work with objects: 
Å Reorder or change the layer of objects by dragging and dropping within the Object Browser. 
Å Edit objects within the Object Browser by selecting the object and using the Popup Menu to make changes. 
 
Notes Browser 
Choose the Notes Browser Icon in the Browser window to create or view page notes.  Note: If a note is included 
for a page, the Page Notes Icon will appear in the top of the flipchart window. To add notes to the flipchart page, 
select and drag the text onto the page. 
 
Properties Browser 
All properties for objects and pages are found in the Property Browser. The selected objectôs properties will be 
displayed in the Property Browser and can be edited using the available options. 
These options, in most cases, remain the same as those offered in previous versions of Activsoftware. 
An option that previously was set using a check or radio button is now set by choosing either óTrueô or óFalseô 
from a popup menu. 
 
Actions Browser 
 
Attaching an Action to an Object 
The process for attaching actions remains the same. The Action Properties of an object are found in the Action 
Browser. 
Å From the drop down menu in the Current Selection Tab, select the type of action to apply. 
Å Choose the Action to apply from the list. 
Å If a target needs to be set or a file is to be opened, use the Browse Button. 
   (Type in the URL of desired Webpage to open). 
Å Click Apply Changes. 
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Voting Browser 
 
The voting browser now includes ActivExpressions activation.  No longer will a separate software be used for 
ActivExpressions-it is part of the ActivInspire.  More details on how to use this browser will be offered as a 
separate training. 
 

Text 

Text edit tools are now located across the top of the flipchart window rather than in a floating toolbox. All text edit options 
remain available.  One new feature with the text is the use of the handwriting recognition tool.  In ActivInspire, the 
handwriting recognition tool can be used with OR without the board. 
 
Handwriting Recognition           and Shape Recognition   
 
Å You do not need to be connected to a board to use the recognition tools. 
Å There is no Recognition Toolbox. 
Å The formatting of text when the Handwriting Recognition Tool is used is determined by the last format used with the   

Text Tool. This applies to the color of the text as well. 
Å The color of the pen will determine the color of the shape object. 
Å Settings for the wait time are located in Edit Profiles>Settings>User Input. 
 

Settings (Profiles) 

ActivInspire has consolidated all aspects of personalizing the profiles 
available in ActivStudio. This makes moving between the five built-in  
profiles or customizing one of your own quick and easy. 
 
From the Switch Profiles Button on the Main Toolbox, choose Authoring.  
The toolset, Flipchart Style, and other profile settings will instantly switch  
to Authoring. You will no longer need to restart the software. Click on the Settings tab to view what tools can be added to 
the Main Toolbox.   
 

Magic Ink           vs. Eraser Tool 

 

 
 
Eraser Tool  
The Eraser Tool has been significantly changed in ActivInspire. The tool now deletes annotations. The 
Eraser Tool applies only to Annotation Objects. Annotations are deleted by the Eraser regardless of 
the layer properties of the object. 
 
 
Magic Ink  
Magic Ink is the way ActivInspire has incorporated the ActivStudio Eraser. The information in 
Activclassroom Module 1 applicable to the Eraser is now transferred to mean Magic Ink. 
 
 
 


